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12th June 2011
11:00am - 4:00pm

Brian Beaney FRPS
'Beyond the moment of
capture'

© Brian Beaney FRPS

Foxton Village Hall, Cambridge
This is the opening event for the newly
formed DIG Eastern Centre.

For full details see the EVENTS listing on Page 4 or contact John Margetts LRPS, easterndigital@ukart.com or 01223 700147

1st July 2011 - 29th July 2011

2011 Members'
Exhibition
Link Centre Library Swindon, Whitehill
Way, Swindon SN5 7DL

Free Entrance
Subject to Library opening times (closed all day on
Monday and on Wednesday pm)

First showing of the Digital
Imaging Group's Exhibition for
2011
For more information contact Alex Dufty LRPS
exhibition@digit.rps.org or 01454 778485
2

Walking the Dog, Paul Radden LRPS

Editor’s Note: Page 38 of the Autumn 2010 DIGIT
(No.47) contained an image called ‘Walking the
Dog’. This was attributed to Paul Radden LRPS.
Unfortunately the image published was by Brian
Burrows. The correct image is reproduced above. I
should like to apologise to both Paul and Brian for
this error. The way submitted images are titled has
been changed to try to prevent such an error from
reoccurring.
RPS DIGIT Magazine Winter 2010/11
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EvEnts
17th April 2011
DI Group Thames Valley Centre: Steve
Caplin
Coopers Hill Community Centre,
Bracknell, Berkshire RG12 7QS
time: 10:00AM - 3:30PM
Contact: Roger norton LRPs
Email: centrecoordinator@rpsdigthamesvalley.org.uk
Phone: 01628 622279
Cost: £10.00, Members Rate: £5.00
Booking essential - more information at
www.rpsdig-thamesvalley.org.uk. season
tickets for 2011 will be available. Free
tea, coffee and biscuits throughout the
day. Bring a pack lunch.
21st May 2011
DI Group Wessex May Digital Day
with Greg Duncan ARPS, and
Members Work
Aldbourne, Wiltshire SN8 2DQ
time: 10:00AM - 4:00PM
Contact: Maureen Albright ARPs
Email: maureen@maureenalbright.com
Phone: 07979 523309
Cost: £10.00, Members Rate: £8.00
Bring Digital Files to show & share or
problems to discuss & solve. Bring a
packed lunch, refreshments available.
tickets ((Please note pre-booked and prepaid) available from Rodney Deval
ARPs, 28 Haywards Close, Wantage
OX12 7At, telephone: 01235 765259.
Please make cheques payable to RPs
Wessex DI Group
22nd May 2011
Thames Valley Centre.
Morning: Creative Photography, Don
Byatt ARPS EFIAP MPAGB BPE4*. A
digital talk showing how to be creative
in the camera and afterwards in the
computer.
Afternoon: The Annual Projected
Digital Image Competition (Judge:
Don Byatt).
Coopers Hill Community Centre,
Bracknell Berkshire, RG12 7QS
time: 10:00AM - 3:30PM
Contact: Roger norton LRPs
Email: centrecoordinator@rpsdigthamesvalley.org.uk
Phone: 01628 622279
Cost: £10.00, Members Rate: £5.00
Booking essential - more information at
www.rpsdig-thamesvalley.org.uk. season
4

tickets for 2011 will be available. Free
tea, coffee and biscuits throughout the
day. Bring a pack lunch.
12th June 2011
A Day with Brian Beaney FRPS
Foxton Village Hall Cambridge
time: 11:00AM - 4:00PM
Contact: John Margetts LRPs
Email: easterndigital@ukart.com
Phone: 01223 700147
Cost: £10.00, Members Rate: £5.00
this is the opening event for the newly
formed DIG Eastern Centre and we have
chosen Brian Beaney FRPs as our first
speaker. this should prove to be a really
exciting day for all those photographers
who are looking for a more creative way
of using their images. the lecture is
entitled 'Beyond the moment of capture'.
Or to use Brian's own words "I try to
bring back to my pictures some of the
"buzz" I experienced when I took the
shot. sometimes the pleasure is just
using the imagination".
A downloadable form for advance tickets
may be obtained from the 'Downloads'
page of the DIG Website at
www.rps.org/group/DigitalImaging/downloads
19th June 2011
DIG Western Centre Regional Meeting
The Merryfield Hall, Ilton, Somerset
TA19 9HG
time: 10:00am - 4:00pm
Contact: tony Poole ARPs
Email: tonyfpoole@gmail.com
Phone: 0117 9565399
Cost: DIG members £3.00, others £5.00
viewing the 2011 DI Group Exhibition,
together with tutorials and other help in
the morning, Members’ work in the
afternoon.
10.00 am, for 10.30am start
26th June 2011
321 International AV Gala Day - 2011
UK
Aldbourne Memorial Hall, Aldbourne,
Wilts SN8 2DQ
time: 10:00AM - 5:30PM
Contact: Maureen Albright ARPs
Email: maureen@maureenalbright.com
Phone: 07979 523309
Cost: £10.00, Members Rate: £8.00
the format will be the same as last year

and has been changed for the UK event.
the entries will have already been
judged in advance of the public Gala
show on sunday 26th June 2011.
this will avoid any over-run, and allow
time for comments from the judges as
well as less ‘down-time’ for the
audience. the Audience will also have
the opportunity to judge their own
favourite sequence at the Gala Day. All
of the sequences have a maximum
duration of 3 minutes 21 seconds, hence
the title of the competition. For the 2011
competition, the entries are being
judged at various locations around the
world, with stages in France, Belgium,
Italy, Canada, south Africa, Mauritius,
Germany, Romania, Oman, switzerland,
Argentina, Australia, Portugal, Poland,
and the UK at Aldbourne.
Bring along a packed lunch,
refreshments available.
tickets: (Please note pre-booked and
pre-paid) available from Rodney Deval
ARPs, 28 Haywards Close, Wantage
OX12 7At, tel: 01235-765259. Please
make cheques payable to RPs Wessex
DI Group
1st July 2011 - 29th July 2011
2011 Members' Exhibition
Link Centre Library Swindon,
Whitehill Way, Swindon SN5 7DL
Contact: Alex Dufty LRPs
Email: exhibition@digit.rps.org
Phone: 01454 778485
Cost: Free
First showing of the Digital Imaging
Group's Exhibition for 2011
14th August 2011
DI Group Wessex Practical
Portraiture Digital Day
Aldbourne, Wilts SN8
time: 10:00am - 4:00pm tBC
Contact: Maureen Albright ARPs
Email: maureen@maureenalbright.com
Phone: 01672540754
Cost: tBC
Bring along camera & a packed lunch,
refreshments available. tickets: strictly
limited numbers. Book in Advance from
Maureen Albright

RPs DIGIt Magazine Winter 2010/11
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Clive haynes frps

FROM ClIvE HAyNES FRPS
Clive Haynes stood down as Chairman of the Digital Imaging Group at the 2011
AGM and handed over to Dr David F Cooke ARPS. He looks back on the
enduring feature of his time as Chairman.

M

y period as Chairman of the
RPS DI Group has drawn to a
close and naturally this is a
time to reflect upon the development of
the Group during my period in office and
to take a moment to consider the changes
that have taken place in digital
photography. I could simply occupy
many paragraph inches by listing the
achievements and growth of our group,
as it remains that largest Specialist
Interest Group in the RPS and probably
the one with the broadest base of
members’ interests, or equally I could
dwell upon the long list of colleagues
without whom the Group wouldn’t have
the stature or be the outstanding success
that it is today. For me, though, the
enduring feature of my time as Chairman
has been the way in which digital
photography has become so embedded
within the fabric of regular everyday
photography that it is now accepted
without question. Equipment has
improved beyond our imaginings. The
resolving power of the digital arrays has
exceeded that of conventional camera
lenses and new lenses have been
designed to match the chips! We’ve
witnessed spectacular advances with
cameras built into cell-phones and
constant refinement of image
management programs. The possibilities
are more exciting than ever. However,
ask yourselves, has the quality of seeing
and final imagery improved at the same
rate? If we’re honest, the answer has to
be “no”. Whilst technology constantly
presents better value for money and a
multitude of accessories, producing
meaningful pictures is still down to
human perception, communication and
sheer ability. No matter how automatic or
easy-to-learn something may appear to
be, regrettably we continue to see the
results of £1,000 worth of equipment in
£100 worth of human hands. And this is
where the shared experience of likeminded enthusiasts and photo-artists can
be of enormous benefit. The DI Group
can provide this and help is also at hand
with numerous photo-societies and online forums. We live in an age of
unparalleled communication – let’s
RPS DIGIT Magazine Winter 2010/11

embrace it.
I like to think that one of the functions of
photography is to be interactive and to be
part of a continuum of communication
between subject, artist and audience.
Certainly many pictures are intended to
inform, to be unambiguous, scientific,
accurate, and perhaps evidentially
forensic. However many other images
are intended to stimulate a response,
indeed to initiate a dialogue, perhaps by
generating curiosity, wonder, disbelief or
amusement. It’s this dialogue and the
exchange it invites that I should like to
explore for a moment. In September
2010 the RPS Journal featured the work
of Albert Watson, Hon FRPS. In this
piece, Albert was critical about audiences
who appear unable or unwilling to enter
into a discussion with the photographer.
Indeed how many times have we
witnessed this event ourselves? A wellrespected photographer is invited to give
a talk about his or her work and time is
allocated for questions. Often there’s an
embarrassing silence. A few tentative
questions emerge, frequently along the
lines of ‘what camera do you use? What
is your preferred paper? What version of
Photoshop are you running? What’s your
favourite lens? I’m sure you all know the
sort of thing I mean. There’s nothing new
about this of course and from my earliest
memories of lectures I recall audience
members asking ‘what film do you use?’
In short, as a general rule, the audience
would appear to be more concerned with
the mechanics of picture-making than the
meaning of the picture or the motivation
of the photographer. Why is this so? Is it
just plain laziness or lack of practice? Is
it so difficult to ask about the author’s
motive, stimulus and artistic intention?
Indeed, when I give talks, I actively
encourage the audience to join in and ask
questions about the pictures. I certainly
keep the whole thing light-hearted and if
not many questions are forthcoming I
start asking the audience questions and
this helps to liven things up! It’s really
quite a simple task to break the ice with a
few well chosen queries to stimulate the
audience. We should invite a greater
dialogue to the benefit of all. This

extended dialogue need not only be
confined to a lecture: what about the
revered club competition? How often
have audiences gritted their teeth and sat
through a whole evening listening to a
judge pontificate about why he/she likes
certain pictures without adequately
explaining why? Why do we do this?
Why not allow a dialogue? There could
be a very revealing exchange of views
between the judge and audience. The
process could tease out many artistic
attributes about images - and why not
invite the photographer to join in to
further explore the work? I’m certain
that the exchange would frequently
enlighten everyone and an improved
learning experience would result. This
more informed approach and exchange
may encourage the movement towards
‘positive assessment’ which could run
alongside the traditional competition
formula. One part of the present
problem could be that of confidence. It’s
certainly very easy for the audience to
sit there and be entertained. When
listening to a lecturer or the opinions of
a judge/assessor, it’s quite natural to
assume that they have the monopoly of
truth. However, this is art we’re dealing
with and an exchange is a vital part of
the experience. We should actively
encourage a dialogue for the greater
understanding of all.
Naturally when starting out with
photography it’s very understandable
that one accepts and learns from
comments about one’s work. This is part
of a feedback mechanism, which if
positive, will lead to the photographer
gaining craft-skills, becoming more
visually aware and, with development,
more expressive. Eventually one can
leave the natural desire simply to
conform or please behind and become
an individual artist with a unique
perspective. Once confidence is gained,
the photographer need no longer be
earth-bound by conventions and
compliance to so-called rules, let alone
the urge to win another ornament for the
shelf.

5
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Steven Le PrevoSt FrPS AFIAP MPAGB

THouGHTS on My
pHoToGrApHy
Steven Le prevost labels himself as a creative photographer and a digital
artist. His style of work has allowed him to receive many major awards
at the very highest levels of national and international salons. He
currently serves on the rpS Visual Art Distinctions panel, assessing
Associateship and Fellowship Applications. In his article he describes
what inspires him and how he creates his images.

Row of Bottles

A

s a fifteen-year-old football mad
teen I recall looking forward to a
weekend away from my
Guernsey home. I was heading for the
big smoke, in the apparent safe hands of
my two older brothers. The highlight of
our adventure was to be the true home of
football, White Hart Lane. Two lasting
memories of that trip away will always
stay with me. The first was meeting
Martin Chivers, my childhood hero and
getting his autograph, which was a dream
come true. The second, and this should
really have put me off image making for
good, was leaving behind a camera in
6

one of those less than savoury
establishments in Soho. It should be
pointed out here that I had to be dragged
kicking and screaming into the area in
the first place. The camera in question
belonged to my father and I can promise
you the whole episode took some
explaining when I returned home. I was
eventually forgiven for losing his camera
but was never allowed to forget. Some
years later my interest in photography
returned and even at this early stage I
was not that interested in the standard
record type picture, I would always look
for that unusual viewpoint with a wide

angle lens or maybe go completely crazy
and open the shutter whilst waving the
camera at a tree or something. In the
darkroom I would experiment with
diffusion techniques like sandwiching
scratched plastic or a piece of tissue
paper in the negative carrier of the
enlarger so I could produce a print with
softer colours and texture. I always tried
to be different and my images at local
club level were being successful. Getting
a print accepted in a national exhibition
was a totally different thing and seemed
an impossible feat.
The digital revolution really did light my
rpS DIGIT Magazine Winter 2010/11
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fire and within just a few short years it
seemed to revolutionise my photography.
The film cameras and darkroom gear
became redundant. Photoshop gave me
creativity at the push of a button and we
all seemed to marvel at the generic filters
offered, but it soon became apparent that
my newly made masterpiece was far
from unique when you could see the
effect being repeated by everyone else. It
was so easy to achieve and became
almost pointless. I felt as though it was
not my work, more the skill of the clever
programmers at Adobe. It seemed to me
the way forward was to use this new
software as a tool to help you achieve
your needs rather than letting the
software decide for you. I subscribed to
‘Digital Photo Art’ magazine to learn
how to use Photoshop, if such a thing is
possible. The magazine really
encapsulated the digital approach and
encouraged a more creative outlook to
your images. On the photographic salon
circuit I noted the names of the
photographers getting awards and tried
to emulate their creativity, not copy it but
more, use their creative work to feed my
inspiration. There seemed to be a general

Lust in Music

Red Lipstick
RPS DIGIT Magazine Winter 2010/11
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Steven Le PrevoSt FrPS AFIAP MPAGB

On Faded Paper

Fairytale
8

trend emerging for soft atmospheric work
and this really appealed to me. Armed
with a computer, Photoshop and bags of
inspiration I began to look at
photography with new eyes. My very
vivid imagination is, I believe, the most
vital element to my image making
process. I began to explore many
different concepts for still life images
with the possibility of working towards a
Royal Photographic Society Distinction
being the goal in mind. The journey to
Fellowship took about two years of very
intensive but very rewarding work. Let’s
be honest it’s not supposed to be easy,
FRPS is the Holy Grail, the top award
that very few will be lucky enough to
reach.
Although still life work will always be a
natural subject for me, I have made a
conscious effort to explore a variety of
other subjects too. It’s always worth
experimenting with fresh ideas,
Imagination and experimentation is key
to my workflow. I keep notebooks with
ideas that I can explore at a later date, I
look at other artists/photographers whose
works influence me, and this usually
inspires me. The aim is to plant the seed
that sets the imagination switch to
overload.
To illustrate this I was recently flying to
Scotland to be part of the judging team at
the Edinburgh International and took
with me some previous publications of
DIGIT magazine to read while travelling,
I noted an idea from one of the articles
that gave me an idea that is worth further
investigation. This is now firmly on my
list of things to do. When creating new
work I am often aware that the finished
print may challenge the fundamentals
and boundaries of known photography.
However, I must say I prefer to use this
approach rather than conforming to the
safe, tried and tested formula so often
seen. To the uninitiated the images I
produce could be perceived as being
created with a few mouse clicks, the
reality however is far from that. Broadly
speaking my techniques are not
Photoshop led, albeit the software is used
to combine all the elements into the
finished work. The process will usually
start with that very essential spark of
inspiration, I will then spend some time
considering the concept, make notes on
possible variations to the theme and then
I can set about capturing the
photographs. It’s a ‘hands on’ approach
and some form of art/craftwork is often
needed to prepare for the photographic
RPS DIGIT Magazine Winter 2010/11
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side. In the case of a still life it may be
literally to build a suitable background to
fit the needs of the picture in hand. The
main subject may also need adapting in
someway and this work will be carried
out before the camera is even considered.
What I am striving to achieve in most
pictures, still life or otherwise, is a
distressed look or a feeling of decay
where colours bleed, the viewer often
questions if this is a photograph or a
water colour. I try to do as much of this
as possible in camera rather than via
software as I find this helps me to get a
feel for the overall composition.
Breaking the so-called compositional
rules is something I will seek actively to
do on numerous images; I do seem to
have a preference for placing the subject
dead centre in the frame. Important
elements of my pictures are the
backgrounds, most of which are created
by hand painting scraps of card with
emulsion paint, applied very crudely
with a cloth, I don’t approach this with
any accuracy; we are not talking good
quality brushes and smooth strokes here.
As you can imagine, my workshop is
filled with junk that may be of use on
future assignments.
One project I am working on currently is
a series of people pictures, either dancers
or actors dressed in Victorian clothing. I
like to visit re-enactment days so I can
photograph them in their costumes and
they are usually only too willing to have
their photograph taken. The messy
backgrounds that were an issue in the
days of film are no longer such a
problem provided you are prepared to
put in the time and effort to remove the
background clutter. My preferred
approach is to photograph the subjects
from a distance and without any
interaction between them and myself,
which ensures there are no cheesy grins
and provides a more natural looking
result that in my opinion suits my work.
With the image captured, all that remains
is to find or create a new backdrop that
will suit. A graphics tablet and pen along
with Photoshop are used to complete the
montage by combining the layers. With
layer masks and blending modes this can
be amazingly accurate. Overall, I tend to
use only two of the Photoshop filters:
Gaussian Blur and Noise. These are
applied via a layer mask so I can target
the effect just where I feel it is needed.
As my style is quite impressionistic I am
often looking to make a fairly vague or
loose suggestion of an item within the
RPS DIGIT Magazine Winter 2010/11

Church Yard

Photograph on the Wall
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Steven Le PrevoSt FrPS AFIAP MPAGB

The Way Home

picture,ahintofafenceorafainttreehiddeninmist.I
findthesetwofilterssuperbforsofteningthesharpnessand
bleedingthecolourstocreateamoreatmosphericfeelto
thefinishedpiece.Thewholeprocessisquiteexperimental
andcanbeverytimeconsuming;onmanyoccasionsif
thingsdon’tpanoutwellyourtimecanbewasted.Idoubt
manywouldrefertomyworkastraditionalphotography
butthathasneverbeenmyintention.
Finally,withallthatartystuffoutofthewayandthe
computerRAMtiredout,theimageisprintedusingan
EpsonR2880printer.MostlyIusethewonderfultextured
artpapersthatarenowavailable.Luckily,Iamasponsored
lecturerforFotospeedsothisgivesmeagreatopportunity
totestdrivesomefantasticpapersthatreallysuitthisstyle
ofwork.Theterm‘lecturing’,Ifeel,makesmesoundlikea
beardedOAPsoIprefertorefertothisas‘illustratedtalks’
andIreallyamenjoyinggettingoutthereandmeetingand
makingfriendswithotherphotographers.

Bottle and Tulip

~-

•==· 1
Fish in the Sea
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Boat in the water
RPSDIGITMagazineWinter2010/11
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Red and Yellow
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MarTin addiSon FrPS

PRInTIng In LIghTRooM 3

Figure 1

Martin Addison provided an introduction to Adobe Lightroom in the
Spring 2010 issue of DIgIT (no. 45, pages 16 to 20). having used it for
several months, he has become extremely impressed by the Print
Module. here, he provides a step by step guide to using its features.

T

here are many good reasons for
using Adobe Lightroom as your
main image handling program.
What initially appealed to me was the
outstanding cataloguing system and the
smooth workflow but after using it for
several months I was surprised to find
myself in love with the Print module
(Figure 1).
So here is a quick guide to printing from
Lightroom 3.
The layout is the same as in the other
modules with the control panels on each
side of the main window which shows
the layout in detail. There are three tabs
in the left panel, Preview, Template
Browser and Collections.
12

The Collections panel now appears in all
the modules and makes it easy to select a
number of photographs in the Library
Module and then to access and print
them without leaving the Print module.
The Template Browser is probably the
most important part of the Print module
as it is here where you can select
particular layouts and use them time and
time again. When I have described the
rest of the panels I will show you how to
create and use the templates.
The Preview area (Figure 2) is where
you can see a graphic impression of the
various saved templates which makes it
easy to select the template which best
suits your needs.

The right hand side contains all the
options for layouts, so let’s go through
this step by step. Remember that once
these options have been set up, you can
save them as a Template and not have to
set them again.
1 Select your picture in the Library and
use Develop to make any alterations
then move to the Print module.
2 At the bottom of the left side click
Print Setup and then Properties to set
the paper size and printing preferences.
You will be familiar with these as they
are the same when printing from
Photoshop.
3 In the Layout Style panel (Figure 3)
select the Single Image/Contact sheet
RPS DIgIT Magazine Winter 2010/11
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Figure 3

./ Zoom t o Fill

./ Rotate to Fit
./ Repeat One Photo per Page

.

./ Stroke Border
,',

.,.,

0.2

Figure 4

option. This is what you use most of the
time. The other options are used when
creating more complex multi-picture
layouts.
4 In the Image Settings panel (Figure 4)
there are several important options:
Zoom to Fill will enlarge the picture to
fill the selected aperture. This may cut off
parts of the picture if the image is not the
same proportions as the layout.
Rotate to Fit, this rotates the picture to
fill the space in the most economical
way. This is particularly useful if you are
printing a mix of landscape and portrait
formats.
RPS DIGIT Magazine Winter 2010/11

Repeat one Photo per page, tick this if
you are printing several pictures on one
sheet and want the same image in all the
spaces.
Stroke Border, this enables you to add a
simple border to your picture, click the
colour swatch to select the colour. You
can also use this to add white space
around the picture.
5. In the Layout panel (Figure 5) you
can set the margins, create multiple
pictures on a page and control the spaces
between them. If you are printing a
single picture, and want it to print as
large as possible, move the Margins
sliders fully to the left and the Cell
sliders to the right. Should you want to
print a particular size, change the Cell
sizes to the size you want. The other
sliders can be ignored for single image
prints.
6 Guides (Figure 6) add overlays to help
in designing layouts, I usually just have
the Image Cells option ticked.
7 The Page panel you don’t usually need.
Here you have some limited text options
and other information. Ignore it for now.
8 The Print Job panel (Figure 7) is very
important and contains all the output
information.
Draft Printing Mode should be left
unticked unless you want to print at a
very low quality.
Print Resolution can be left unticked.
This allows Lightroom automatically to
select the best resolution for the size you
are printing. I find this works very well
although you can set it yourself if you
prefer.
Print Sharpening, I nearly always leave
this turned on. Lightroom uses a very
sophisticated output sharpening process
which applies the correct level of
sharpening, adjusted for the print size
and paper. This output sharpening is
quite separate from any sharpening you
make in the Develop module and I have
never known it to over sharpen any
picture - and I am very critical of over
sharpened pictures. The options are
Low/Standard/High and I usually leave it
on Standard. You should also select the
paper type Glossy/Matt as LR will apply
different levels.
Finally Color Management, the all
important way to get the correct colours
in your print. I am not going to cover the
process of getting profiles created and
installed as I will assume that you know
this, so click the Profile option (the
default is Managed by Printer) and select
the colour profile for the paper you are

Figure 5

Figure 6

Figure 7

using. The first time you use this you
will have to select ‘Other’ and the list of
your installed profiles will appear, tick
the ones you want to use (a lot of them
will not be relevant) and those will
appear as the options in future.
You can also change the Rendering
Intent here if you wish, but I usually
leave it on Relative.
9 Now that has taken a long time and
you might be thinking that you can do it
a lot faster in Photoshop! But wait for
the next step.
10 In the Template Browser panel
13
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!
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Create

Figure 9
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Can«!

I

(Figure 8), click the + sign to the right of
the heading and give it a name in the
dialog box which appears (Figure 9).
This should reflect the settings you have
entered, for instance it might be:
A3 Fit on Page Oyster paper - or...
A4 24 x 36 Matt paper
You should use a name to make it easily
identifiable next time you want to use it
and it will probably include the paper
size, the aperture size (or fit to page) and
the paper type. Click OK.
11 This has now saved all these settings
as a template, so the next time you want
to print to the same paper etc, you simply
select your picture, go to the Print
module and press Print One and it will
print immediately. You do not need to do
anything else.
12 If you want to use most of the
settings, but are using a different paper,
click on the saved template, change the
paper type (and perhaps the sharpening)
in the Print Job panel and click on the +
sign again to save it under a new name,
so now you have 2 templates.
13 Every time I print and use a different
setting I tend to save it as a new template
as I am quite likely to want to use it
again. Currently I have about 40

templates saved and I organise them into
folders A4, A3 etc - you can see them in
the screenshot.
14 Lightroom comes complete with
quite a number of Templates, many of
them for multiple pages on a sheet and
often it pays to find one similar to what
you want and then alter certain options
until it suits your need, then save it
under your own name. You can preview
what these look like in the Preview box
top left, just run your cursor down the
list of templates.
15 To create templates which have a
number of different sizes on a page, go
to the Layout Style panel and select
Picture Package. This brings up a
different view and you can add, move or
resize boxes very easily. Another set of
options will appear when you select
Custom Package and in this layout you
can drag and drop pictures onto the page
completely independent of any preset
sizes.
I recommend Lightroom very highly for
printing. I get exceptionally good results
and it is fast and easy to use. Some
multi-image layouts are shown in
Figures 10 to 13.

Figure 10
14
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Figure 11

Figure 12
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CLive Haynes FRPs

MAKInG AUDIO-VISUAL
ShOWS WITh PROShOW
PRODUCER
Clive haynes has been producing Audio Visual (AV) presentations since
the mid 1960s when he and his brother used manual slide projectors, a
mechanical iris ‘dissolve’ system and reel-to-reel tape machine. The
technology has changed a lot since then. here, he describes ‘ProShow
Producer’, one of a number of affordable and versatile programs on the
market.

Transition Time (secs)

Figure 1

D

igital Imaging increasingly offers
photographers and creative artists
the ability to explore numerous
methods of working and options for
presentation. Once an image has been
captured it can be translated readily to
different media e.g. prints, (mono or
colour), projected imagery and audiovisual (AV). The marriage of pictures and
sound has a long pedigree and is now
more accessible than ever before.
My own adventures in AV began with my
brother, Malcolm, in the mid 1960s. We
used a pair of Leitz ‘Pradovit’ manual
slide projectors, a mechanical iris
‘dissolve’ system and reel-to-reel tape
16

machine. We moved to a Kodak Carousel
based presentation using pulse and glidetone electronics, which in its turn became
more sophisticated with the introduction
of computers and a professional
Electrosonic system to control our, by
then, seven projectors. Eventually the
large-scale outfit was ‘retired’ and
together with colleagues, I waited for
digital systems to develop and to become
reasonably affordable. Today, there’s no
doubt about the quality of digital
projection and the price of data projectors
is now within reach of the enthusiast.
Computer-based AV systems need a
method of synchronising images and

sound and we are fortunate that
there are several very affordable
and versatile programs available.
In making a choice, one simply
needs to look at one’s goals in
terms of presentational needs,
audience expectation, program
versatility, levels of
sophistication, ease of use and
depth of back-up. The most
popular contenders for the needs
of enthusiasts are, ‘Pictures to
Exe’, ‘ProShow Gold’ and
‘ProShow Producer’, these last
two are products of Photodex
Corp, USA. After exploring the
facilities and options offered by
all three, I decided to opt for
‘ProShow Producer’ as this
program, admittedly the most
expensive of the three, ‘ticked all
the boxes’ from my point of
view. As many digitalphotographers may also be faced
with a similar choice, this piece
illustrates how ProShow
Producer works for me. In this
overview, I thank my colleague,
Martin Addison FRPS, with
whom I work closely in
developing our joint AV
programmes, for his advice and
input. Indeed, Martin shared the
learning-curve with me during
our collaborative AV
presentations from the mid
1970s to the dawn of the new
millennium and now we’re once
again exploring new (AV)
worlds.
This isn’t intended as a sort of
‘shoot-out’ review comparing
one program with another, as all
RPS DIGIT Magazine Winter 2010/11
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will meet most of the needs of
the enthusiast, but simply a
presentation illustrating how the
workflow and options offered by
‘ProShow Producer’ fulfil a
particular high-level of
requirement.
Preparing Images
This is one significant area
where ProShow Producer (PSP
for short) has a distinct
advantage. When sorting and
storing the images for the show,
there is no need to resize, indeed
such is the versatility of PSP,
that if needed, RAW file images
can be added directly to the
image store. With large image
files as a resource, PSP converts
the image data to the size
required at the point when the
show is ‘created’. This offers
great flexibility as images for
AVs can be resized without loss
in minutes, making it simple to
upgrade a show to a higher
resolution as data projectors
evolve and improve. In this way
programmes made with
ProShow are to some extent
future-proof. It’s important to
remember that the source files in
the PSP image store always
remain at their original size.
However it must be emphasised
that in common with good
practice for all imaging
programs, the image file should
be large enough to begin with, as
just for any image, up-sizing /
up-sampling should be avoided.
I’ll say more about this topic
later.
A note about nomenclature: PSP
refers to images as ‘Slides’, this
is a legacy from the days of
transparencies and is a charming
American convention. For clarity
of explanation, I will also use
‘image’ where helpful.
Getting Started
Make a new folder to contain all
the images (slides) for the show
as an ‘image store’. The picture
order isn’t important as this is
simply a storage location.
Open PSP, navigate to the Image
Store and simply drag and drop
the slides on to the ‘timeline’ at
the base of the large dialogue
box. A slide can be dropped into
the sequence at any point, as
RPS DIGIT Magazine Winter 2010/11
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Figure 2 Choose your Transition from around 500 effects.
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Figure 3 A section of the 125 Slide-Style pre-sets list.

illustrated in the screen-grab. (Figure 1)
Slides
Once the slides are in show sequence, the
program helpfully places ‘tick’ marks on
those selected (and yes, you can use the
same slide more than once). You can edit
the sequence, add new slides, set
transition and duration timings, edit the
sort of transition (Figure 2), add vignettes
and masks, adjust individual slide settings
(colour, contrast, brightness, etc), add text,
styles, special effects, backgrounds,
blends, motion and panning, screen aspect

ratio, etc. Many styles (Figure 3), effects
and transitions can be downloaded from
the Photodex website and other links.
Audio
Save the audio track you need for the
show to one of the major formats (MP3,
WAV, Ogg Vorbis, etc) and pop it into the
show store folder. To add audio to the
program, simply drag & drop the audio
file onto the audio channel track at the
base of the dialog box. The audio file will
be displayed as a waveform along the
baseline. The audio track can be edited
17
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Figure 4

Figure 5 Slide Options. Showing some of the many Layer Tabs for the selected slide.
Note: A soft-edge has been applied as a ‘Vignette’. In this screen-grab, four Layers
are illustrated, two to form the edges (one of which will be ‘mirror-flipped’), one for
the centre image (with vignette) and one as a background.

Figure 6 Screen-grab to illustrate how the active layer is ‘flipped’.
18

and faded in and out to meet the needs of
the presentation. (Figure 4).
Layers
In common with other, similar programs,
PSP includes ‘Layers’ and this facility offers
many adjustments. (Figures 5 & 6).
Key Frames
Huge benefits are gained from the ‘keyframing’ facilities. This could occupy a
whole article in itself. In short:
‘Keyframing’ allows the user to set the
beginning and end points for a particular
effect or motion. The program will
automatically work out a path between the
two keyframes. Additional keyframes can
be added to expand its use and versatility.
This is certainly one big advantage that
ProShow Producer has over its companion
ProShow Gold. Keyframes are illustrated in
Figure 7.
To this point we have a general overview
illustrating how simple it is to get the
images in show sequence order, set basic
timings and ensure the audio-track is ready
and in place.
As a first run though, the AV can be
replayed by using either the editing window
or as a full-screen presentation. Obviously,
it’s helpful to view the program in the
editing dialogue box as everything is visible
for adjustment and refinement.
To illustrate this article, I’ve used screengrabs from one of my AVs and this
sequence includes careful use of zoommotion. PSP has many motion-effects
features and Figure 7 shows a Motion
dialogue box with Keyframes. As a detail of
production workflow, Figure 8 illustrates
how easy it is to make a soft-edge ‘vignette’
for a slide.
Efficient Workflow and Short-Cuts
A cleverly evolved design, particularly in
the interests of maintaining a speedy and
efficient workflow is demonstrated by
numerous time-saving features such as the
ability to copy settings, layer features or an
effect as applied to one slide then paste, en
masse, to a series of other slides in the
show.
Most imaging programs include a wealth of
short-cuts to enable speedy working and
PSP is no exception.
Final Stages, Creating the Show for
presentation
Once you’re happy with the show and ready
to finalise it, there are decisions to be made
about resolution and output. This is where
we return to the important factor of
‘resolution’. With the slide or image store
for the program containing images at full
size, it’s possible to set the output resolution
when one is ready to “Create” the show. At
RPS DIGIT Magazine Winter 2010/11

18,19 DIGIT Winter 2010-11_448-471 Talbot 28/03/2011 06:50 Page 2

this point one can choose the
resolution that best suits the
viewing media. The images in the
‘store’ are unaffected by these
decisions, the settings chosen only
apply to the ‘copy’ file that’s
created at this output stage. This
is really useful particularly
because, as the requirements for
presentation advance, the output
file resolution can be altered to
suit the media. Typically the show
created will be an .exe file.
However, the ‘Create’ stage also
includes facilities for DVD
(replay on TV systems), Blu-ray,
video, web, U-Tube, etc.
Instructions
The program comes complete
with a very comprehensive 550
page PDF instruction manual.
In Summary
ProShow Producer is an excellent
program which enables us to
make AV shows from the most
simple to the highly sophisticated.
Closer acquaintance constantly
reveals levels of thought and
planning making its operation
smooth and intuitive.
Photodex has arranged for a 20%
discount to be available to
members of the Digital Imaging
Group. The Discount coupon and
instructions for its use are below.
The ProShow Producer website
is:
www.photodex.com/products/pr
oshow/producer
Editor’s note: Proshow Producer
is designed to run in Windows.
For details of how to run it on a
Mac please see:
www.photodex.com/support/reso
urces/howto/mac

Figure 7 Editing the start and end positions for a ‘zoom’ using ‘Keyframes’. In this example the centre
slide layer was’ zoomed-in’ to position. 1: Keyframe previews: the start and end points for the effect /
layer; 2: Keyframe timeline: controls when the keyframes happen; 3: This list area selects the layer
the keyframe is applied to; 4: Starting and end values to configure settings to keyframes selected; 5:
Keyframe toolbar for quick access.

Figure 8 Editing the vignette.

/ r_PHOTODEX'
~

20%
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I

OFF

CODE: TXVVlKSN

CORPORA T IO N

PROSHOW®WEB, GOLD OR PRODUCER

EXPIRES: May 1, 2011

ProShow Producer, boxed edition normally $269.95 for only $215.96. ProShow Gold, boxed edition normally $79.95 for only $64. ProShow Web Plus norm ally $30/year only $24. ProShow Web Premium normally $150/year only $120. To redeem call the number below and
provide your sales rep with the discount code above, or email support@photodex.com to arrange a callback.
This coupon bears no monetary value and may not be combined with any other offer. Offer only valid when discou nt code is presented
at time of purchase. Shipping and handling charges still apply. Discount valid for boxed and electronic-only versions as well as upgrades.

PLACE CODE IN THE PROMOTIONAL CODE FIELD WHEN ORDERING ONLINE AT PHOTODEX.COM
OR CALL: 512-419-7000 I 1-800-37-PHOTO
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USING PHOTOSHOP TO
REvEAL TEXTURE
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Figure 1 Custom filter settings

M

any photographs can be improved by having
the latent texture therein being made visible.
Close up macro work can benefit especially
from this technique if used in a subtle manner.
Generally, it involves making either a Bas Relief or
Embossed duplicate layer of the sharpened original
and changing the blend mode from Normal to Overlay.
Usually sharpening is the last thing to be done, but if
carried out before using this technique, then the final
effect is more easily seen on screen so that adjustments
can be made before it is too late!
Method
1. After applying the unsharp mask, save the file now!
If using the Bas Relief technique, change the bit depth
per channel to 8bit if using 16bit or higher
(Image>Mode>8bits per channel). NOTE:
Filter>Stylize>Emboss and Filter>Other>Custom will
handle 16bit files.
2. Make a duplicate of the background (Ctrl + "j")
3. Change the blend mode from Normal to Overlay.
4. Apply Filter>Sketch>Bas Relief with Detail=13,
Smoothness=2, Light from Top Left or the same as the
lighting angle of the original. If 16bit files are used
then the above has to be modified slightly in order to
retain the extra colour information available:Image>Duplicate and name it "8bit".
Mode>8bits/channel.
5. Make a duplicate of the background (Ctrl + "j").
6. Change the blend mode from Normal to Overlay.
7. Apply Filter>Sketch>Bas Relief with Detail=13,
Smoothness=2, Light from Top Left or the same as the
lighting angle of the original. Do not flatten the layers!
8. Select>All. Edit>Copy. File>Close without saving.
(This copies the Bas Relief layer only)
9. Edit>Paste and change the blend mode from Normal
to Overlay. Done! The background (layer) has retained
all of the 16bit colour information of the original. The
action supplied uses this method which also works
with 8bit files.
10. If too much texture is revealed, reduce the opacity
of the Bas layer to 75% or even 50% to suit the
subject.
11. Try cycling through the blending modes for some
20

different effects (pictorial NOT
nature!) before flattening.
12. Finally, flatten
(Layer>Flatten Image) & Save
as.... (new file name).
The Bas Relief method can give
rise to an effect in skies
especially, which looks like the
contours on a map!
The Emboss technique described
next does not do this.
3D texturizing can also be done
using Filter>Render>Emboss in
lieu of the Bas Relief filter when
a slightly different effect is
obtained. Try the following
settings: - 135° angle, Height 3
pixels, 500%. It is a good idea to
desaturate the layer to avoid
introducing false colours from
the embossing filter. Again this
layer must have the blend mode
set to Overlay. A 1 pixel height
gives a more subtle effect.
A third method is to use
Filter>Other>Custom either
directly on the background layer
or preferably on a duplicated
background layer (Ctrl + "j").
The screen grab (Figure 1)
shows the settings used for the
example in Figure 5.
If preferred, the -2s can be
replaced with a single -4 in
either the very corner box or the
one where the innermost -2 is
sited. This creates a subtle
difference only however.
As always, different subjects
will respond better to one
particular technique so it is
worth trying all three methods
on each of your images every
time. This is most easily done
using the actions I have written
to accompany this article.
If it is desired to retain the extra
colours of a 16bit original file
when using the Bas Relief filter,
before flattening and saving,
copy the Bas layer to the
clipboard (Select> ALL, Edit>
COPY, Select> DESELECT),
File>Revert (F12 hot key), then

Paste (Ctrl + "v") and set the
blend mode to Overlay. Flatten
& Save as .... (new name) the
now 16bit file with all the
original colours.
Changing the angle of light by
180° will cause previously
sunken details to appear raised
and vice versa.
It will be interesting to see if the
above techniques are acceptable
to nature photographers as
nothing is being added, merely
the latent texture in an image
revealed. I personally have no
problem with this provided this
is not done to excess or if it
looks unreal.
The orchid image was taken on
a Canon 40D EOS camera,
430EX flash, 100mm, f2.8L
USM IS macro lens at f22.
The RAW file was converted in
CS5 Camera Raw as a 16bit file.
Then sharpened with Unsharp
mask.
Figure 2 is the Original image
sharpened. Figure 3 has had the
Bas Relief filter applied. Figure
4 has had the Emboss Filter
applied. Figure 5 has had the
Custom filter applied.
None has been faded or
retouched. Dust on the flower is
now revealed!
The action set "3D Texture
effects by JW.atn" is to be found
and downloaded from
http://sites.google.com/site/
digitdownloads/ and includes
all three methods above, which
have been tested in Photoshop
CS3 and CS5.
AUTHOR'S FOOTNOTE: Users
of this texture generating
technique should be aware that
a colour variation can be
interpreted by the computer as
latent texture. This can add
interest to a pictorial picture but
may be inaccurate if applied to
factual subjects e.g., record or
nature, and therefore should be
used with care.
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Figure 2 Orchid Original with Unsharp Mask

Figure 3 Orchid Original with Unsharp Mask then Bas Relief
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Figure 4 Orchid Original with Unsharp Mask then Emboss

Figure 5 Orchid Original with Unsharp Mask with Custom
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Figure 1

Janet Haines is a keen user of the Digital Imaging Group’s own Forum
on the RPS Server. In particular, the ’Images for Discussion’ area where
members can post one image a week for comment by other members. In
return, they comment on others’ images. She explains the benefits of
joining the Forum and how to do so.

M

embership of the Digital
Imaging Group is now just
over the 1000 mark. Of
course we all get the quarterly copies
of this super magazine, which is well
worth our additional £15 per year
subscription in itself. But how many
of us take advantage of what else is
on offer?
Did you know that as a member of
this Special Interest Group the RPS
Forum can offer you a whole lot
more?
RPS DIGIT Magazine Winter 2010/11

Talking to Tony Mant (RPS) he tells
me that as an ordinary RPS Member
you can only see the sections on the
forum down to ‘Odds and Ends’
(Figure 1)
But there is a whole lot more awaiting
you and a great deal more ‘value for
money’ to be had. Hidden below
‘Odds and Ends’ is the Digital
Imaging Group special section. This
now partly replaces all the various
previous web sites that we have had
over the past few years; courtesy of

Bill Henley and Maureen Albright.
These two older incarnations were
housed outside of the RPS main web
site and run separately by these good
folks. Now we have come in out of
the cold and are the only Group to
have a separate forum on the RPS
server. It has the same look and feel as
the main RPS area - but the secret is
how to find it!
It’s easy. A quick email to Tony Mant
(tony@rps.org) and he will ‘switch a
switch’ and just like magic the Genie
23
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Figure 2

appears. Now below ‘Odds and Ends’
comes a whole new area to be
explored (Figure 2). No further names
and passwords are required to access
this area – this is something that
many of us have been confused about
and has often caused Tony time and
effort with individuals to sort us out
(me included – thanks Tony).
For me the very best section is the
‘Images for Discussion’ area.
Surprisingly only 2% of the members
use this facility, so the other 98% of
you are really missing a trick here.
Once a week you can post one of
your images for review and feedback
24

from other members, and we all
know how valuable constructive
feedback can be in assisting us to
improve our work. Posts which
regular members make cross all
spectrums of digital photography,
some producing straight images and
others high art works of self
expression. We are very polite to one
another and the feedback is
constructive and supportive, often
with a bit of humour when
appropriate. It is all very enjoyable
and our virtual friends all contribute
both interesting images and genuine
feedback. What I cannot for the life

of me understand is why more of you
do not take advantage of this forum.
An individual can post once a week,
uploading their image either direct to
the RPS server using the upload
feature, or you can link out to an
image hosted on an alternative site
such as Flikr or Photobucket by
pasting in their link code. Out-linking
has the advantage that images are
often displayed slightly larger than
the RPS server provides, but either
method is perfectly valid and
acceptable. In Figure 3 I show one of
my weekly postings where the image
is actually resident on my
RPS DIGIT Magazine Winter 2010/11
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Figure 3

Photobucket site. You will see that the
presentation of the forum is clean
looking and intuitive with respect to
‘add reply’ or ‘start new topic’.
Postings are ‘live’ for one week.
During this period other members can
visit and comment and the unwritten
rule is that if you post you also
comment on others’ work too. We
often make changes to our work and
re-post the modified image mid week
if members are making good points.
This way we can all see if it really
was an improvement or not. But on
Friday the axe falls and the lock goes
on. No more commenting, but the
RPS DIGIT Magazine Winter 2010/11

images do remain to ‘view only’ for
many months.
Watching the statistics I suspect some
of you view the images but leave it at
that, not bothering to comment or put
up your own work. Don’t be shy – we
are very gentle with new-comers! You
really do have something to gain
from joining in.
And it doesn’t stop there. As you can
see in Figure 2 other sections include
the ‘How do I’ section. I find this
really helpful when I am stuck with
something as you can be sure there is
someone out there who not only
knows the answer, but will willingly

share his or her knowledge with you. I
won’t go through them all laboriously
as you can see for yourself from the
headings on the screen grab what
these are.
So if you aren’t already taking
advantage of this special area within
the RPS site then do send Tony an
email and get ‘switched on’. Whether
or not you choose then to post images
is entirely up to you, but you will be
made very welcome if you do.
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Jim ClaRk

THe DIgIT cHAllenge
This time we have five images from DIg members who explain how they created them. I
hope you’ll find these interesting and helpful techniques to use in your own photography. If
you do, why not join in and send some of yours to me at: davidfcookearps@gmail.com.

“Rockers”

“Rockers” by Jim Clark: This
photograph is extremely simple. It was
taken from my wheelchair, which I have
been confined to for a couple of years
and which unfortunately limits the
photos I can take. However, this
summer I was able to get to our house
at Ars, on the Ile de Ré. One day I was
pushed to the market by my daughter.
In the market I went past this group of
resting musicians that I call “Rockers” –
probably a misnomer. They were
snapped en passant. I later cropped the
picture and applied Topaz Adjust 3
choosing the HDR Pop, which I then
lowered to about 80%.
26

Lost Memories
The Original Image
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MARtin AddiSon FRPS
Lost Memories by Martin
Addison FRPS: The original
photograph was taken with a
compact camera in Worcester, I
had borrowed the camera from
John Wells as we had swopped
cameras for a couple of hours, he
had my DSLR with fisheye lens
and I had his compact. We both
enjoyed the experience! The
photograph was of a derelict
building about to be demolished
and what attracted me was the
peeling paper and the colour
combination of blue and cream.
All my photographs are imported
into Lightroom and having
decided to work on the picture I
took it into the Develop module
and started by cropping to a
square format. I have used the
square format a lot for several
years and it works really well for
so many pictures. It is surprising
how a change of format can
completely change the way a
picture is read by the viewer.
I wanted to make it very delicate
and ethereal and take away the
rather mundane quality of the
original so I made adjustments to
quite a number of sliders. The
first block are in the Basic panel.
Exposure to +1.89 to lighten the
overall tone
Fill Light to 55 to keep the
darker tones very light
Blacks slider to zero for obvious
reasons
Contrast to - 22 as I wanted a
fairly flat tone
Clarity to - 45 this slider is great
for adding a delicate softness
In Curves I brought the
Highlights slider to -39 as I felt
the highlights were a bit strong
In Detail I took the default
sharpening off and increased the
Noise reduction to Luminance +
83. I didn't need to remove any
noise, I just wanted to add a little
extra softness.
I added a Vignette, Amount +77,
Midpoint 0, Roundness -100 and
Feather + 100. These sliders
need playing around with in
combination to get the effect you
need. In this case I wanted to add
a soft border without creating a
circular vignette.
I also used the spot removal tool
to remove the small orange
RPS DIGIT Magazine Winter 2010/11

Lost Memories

seeds. Then I printed it in Lightroom using
a preset square format onto Permajet
Papyrus paper, which is a wonderful surface
to use for this sort of delicate images.

All this was done in Lightroom 3, but if
you don't use Lightroom, you could do
most of this in Camera RAW in Photoshop
CS5.

The Original Image
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ALAn DeDMAn LRPS

Magical Woods

Figure 1

Figure 2

Magical Woods by Alan Dedman LRPS: Every Autumn I
go into the woods for some images of the wonderful
colours. Every year I look at what I have captured and think
that I have not managed to catch that essential magical
quality. I look at other people’s images of autumn and get
the same feeling. Wonderful as many of them are, they tend,
to my mind, to be record shots. So for my own enjoyment I
set out to try to create a more magical image of the woods
28

in autumn. I wanted an
image that was dark, rich
and with some of the
wonderful side lighting you
get at this time of the year.
Figure 1 is a straight shot of
a woodland path. I took
several on that occasion.
The good thing about
digital photography is that it
allows you to throw away
what you don’t want
without running out of film.
All the shots I took were
bracketed, one stop over
and one stop under. The
under exposed images
turned out to be the best for
my purpose.
From the straight image and
using ‘Corel Paintshop Pro’
I played with the levels and
curves until I got what I
thought was the most
natural rendition. I created a
duplicate layer and using
‘Low Key’ from the Nik
software collection I made
a darker, richer layer. I
changed the ‘saturation’ and
the ‘glow’ to achieve what I
thought looked best. With
Paintshop’s ‘New mask
layer> Show all’, being a
layer over the original, I
was able to use a large,
very soft, brush to paint

back in the brighter sun
caught highlights from the
original layer underneath. I
did this several times
before I got just what I
thought was right and how
I wanted it. I then applied
the ‘Pastel’ filter from Nik
lightly to various areas, as I
had used the ‘Low Key’
filter.
I decided that a figure was
necessary and from shot
number two (Figure 2) I
took out the lady, turned
her round, and gave her a
shadow. I made sure the
‘saturation’ and ‘glow’
were similar.
I then used the simplifier in
various settings for
different parts of the image,
masking and brushing till I
had finally created the final
image.
There was no precise
formula that I followed. In
fact I did it over several
days which allowed me to
consider better each stage.
At each point I had saved
the image so I could dodge
back and forth.
To my surprise many
people have said how much
they like it.
RPS DIGIT Magazine Winter 2010/11
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JoHn Long ARPS

Harley Man

Harley Man by John
Long ARPS: The original
shot was taken with a
handheld camera from a
low angle and using a fill
flash.
I started by cropping the
image to give me the
composition I required. The
background was then
desaturated and I carried
out extensive cloning and
darkening around the
edges. Finally, it was taken
into Topaz ‘Adjust’ (a
Photoshop Plug-in) and I
treated the image to create
the feel I wanted.

The Original Image
RPS DIGIT Magazine Winter 2010/11
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OLive LintOn LRPS

Chrysanthemums and Roses

Chrysanthemums and Roses by
Olive Linton LRPS: I recently
received three Nikon body caps
with pinhole sizes of 0.20mm,
0.25mm and 0.35mm as one of my
birthday presents. Being a retired
laboratory technician who has not
30

yet lost her interest in
experimentation and who still has
an undying sense of adventure, I
decided to attempt some pinhole
shots for the first time using the
0.25 pinhole. I took my Nikon D80
camera, removed the lens and

replaced it with the body cap. I
was now all set for the pinhole
project and went out to look for a
suitable subject.
After some initial experimentation,
I decided to shoot some flowers in
a vase which I thought were
RPS DIGIT Magazine Winter 2010/11
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'fading' rather attractively. Although I
don't have any studio lighting set up, I
do have a recessed side window in my
living room which I thought might do
as a suitable position for the shot. I
placed the vase of flowers there and
took many trial shots while the
creative urge was on me. I found it
was quite difficult to place the camera
at the correct height and distance in
relation to the vase of flowers as I
didn't have a tripod at the time. I
achieved a satisfactory result finally
by trial and error. I had tried various
shots in turn by placing the camera on
top of the fire surround, on the
opposite window sill, the arm of a
settee and even eyeing at one point my
cat Alfie who was curled up asleep
and motionless on top of a bookcase.
In the end however I put the camera
on my ironing board which I moved
backwards and forwards until I found
a 'correct' position. At the same time I
tried to ignore the mountain of ironing
which I could see out of the corner of
my eye piled up accusingly in another
room. I shot in RAW with a 30
second exposure, ISO 800 and Manual
setting. I used the self-timer to avoid
camera shake.
I used a standard lamp to add a bit of
spot lighting to the flowers. I had a
rough idea of what I thought the final
picture might look like i.e. soft and
romantic and painterly. The pictures
shown here are from the first cropped
PSD to the final one. I had to crop off
the curtains and shelf in the original
RAW file in order to get just the vase
of flowers and shadow (Figure 1). I
then 'beautified' the background by
using one of the filter effects in 'Nik
Software Color Efex Pro 3 Complete'
(Figure 2). I had a free download trial
for fifteen days. It’s fantastic software,
albeit a bit expensive, but highly
recommended if you are feeling
wealthy. I expect it could all be done
in Photoshop, the hard way, instead of
a few clicks in Nik software but I took
the lazy way out when I had the
opportunity. Finally, I added a
textured border to the picture by
enlarging the canvas size. This made it
look more like a painting.
I haven't yet decided what my next
pinhole attempt will be. Maybe a
people shot? I might even try to
combine a pinhole with an infrared
shot. Now that could be very
interesting…
RPS DIGIT Magazine Winter 2010/11

Figure 1: Crop from original file

Figure 2: Nik Color Efex Applied
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